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PREFACE

Computeris the basic need of this modern era. Now-a-days it is using in very offices
and houses. Computer has brought about drastic changes in our life. People in all
fields of life use computers to perform multipurpose tasks.

The series of eight books for classes 1 to 8. The series has been delivered and
designed in such a way that a child can understand the basic concepts of computer
and its applications. We have tried to achieve our objective through interactive
updated contents and activities presented in a learner friendly manner focusing on

the activity - oriented computer education.

Salient Features of the Books:

& Simple language, exciting and meaningful illustrations are provided to

elucidate the concepts.
& Let’s Know section is given at the start of each chapter to recapitulate the
important points.
Did You Know section presents interesting information to take learning
beyond the given text.
Activities within the chapter develops technical and cognitive skills.
The aim of our books is to make students understand the working and
applications of computer on their own.
Every efforts has been made to keep the series worthful, but still the door is open
for your valuable suggestions for the improvement of the series. Your suggestions
will be gratefully acknowledged and will be given due consideration in the
subsequent editions.

Authors
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INTRODUCTIONTO
COMPUTERS

_ @ Typesof Computers @  Usesof Computers x

|

< Types of Computers

Personal Computers or PCs are small computers meant to be
used by a single person at a time. They are the most common
type of computers, we see around us. Lets us learn about
different types of personal computers.

Desktop Computers

This is a type of Personal Computer which is kept on a desktop
or tabletop. It has a separate keyboard, mouse and monitor. The
different parts are connected to the CPU through wires. A
desktop computer is not portable. We can't carry it along for use.

s Did You Know?

These computers are kept on desk and are commonly found in schools,

colleges, shopping malls, railway stations, hospitals and so on.

Laptop Computers
These are portable computers and can be used on laps. They
are battery operated and small in size. They are commonly
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" users prefer to have laptops than desktop computers.
Tablets

Tablets are smaller than laptops and have a touch screen
interface. It is a portable computer and you can carry it along
wherever you go. Its battery when charged can keep the tablet
running for several hours.

Smart Phones

Modern day smart-phones also work like computers. They can
be used to browse the Internet, send e-mails, create and save
documents, pay bills and reserve railway and airline tickets.

< Embedded Computers

Many modern day devices and gadgets like automatic sewing
machine, aeroplane, television etc., have very small computer
chips fixed inside them which
we cannot see. These are
called Embedded computers.

5 Did You Know?

Desktops, laptops, tablets and smart-phones are different types of
personal computers. But embedded computers are different. They are
fixed inside a device and perform a fixed set of functions.

Aeroplane  Television Sewing Machine

< Uses of Computers

Computers are being used in almost every area of human activity.
In the previous classes, we have learnt about a number of uses of
the computers. Let us learn a few more uses in diverse fields.

‘Q 6 Computer-3
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Making Interactive CDs \%ﬁ

Computers are used to create interactive educational CDs.
Children can use these CDs to learn their subjects in an easy
and interesting way, right on their computers.

Playing Games on a Computer
We can play games such as car racing, g8
chess, cricket, tennis, basketball and
football on the computer.

In Flying Airplanes

Computers are also fitted in airplanes. These
computers give all necessary information to the
pilots for flying the airplanes like the speed of
flying, height at which the airplane is flying,
weather conditions etc.

\g

In Television Broadcasting

Computers are widely used in the field of
telecommunication and television
broadcasting. They are used in the
television studios to create and record
programs and send them in the form of Television broadcasting
signals across the world.

!

s Did You Know§

Computers help doctors to perform operations, diagnosing many

diseases and preparing medical reports.
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&'Let’s Recall L./
& .

A computer is an electronic machine. It works on electricity.

Charles Babbage, who invented the ‘Difference Engine’ and
the ‘Analytical Engine’ is known as the ‘Father of Computers..

Computers are being used in many fields of activity
including education, animation, CAD, TV broadcasting,
browsing the internet, flying airplanes etc.

S THEEENEE

A. Fill in the blanks.
1. A computer is an electronic machine. It works on

..................... and helps us to do our work easier and faster.
20 are being used in about every area of human

3. A computer is not portable.
B. Write ‘T’ for the True statement and ‘F for the False
statement.
1. Desktop computers are kept on disk. L
2. Atabletisapersonal computer operated by touch. )
3. Computerarealso fitted in airplanes. ]
D. Answer the following questions.
1. Whatdoyouknowaboutsmart phone?
2.  Whatisthe difference between tablet and laptop?

)¢ 3,

How do you use computer at your home? |
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PARTS OF A COMPUTER

. @ Computer Hardware - Input and output devices, CPU, memory an
storage devices.

@ Computer Software - Operating system software and application
software.

The computer has many parts. We can categorize
them as hardware and software. ]

Those parts of the computer, which we can see, touch and
hold in our hands are called hardware.

Software are those parts of the computer, which we cannot
touch or hold.

< Computer Hardware

The hardware parts of the computer can be put into four
major categories - Input devices, Output devices, CPU and
Memory & Storage devices.

Input Devices
Input means to enter data into the computer, are know as
input devices. Keyboard, mouse, joystick, webcam,
microphone and scanner are some common input devices,

? Computer-3 9 "
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& Did You Know¢

‘ Microphone was invented by Emile Berliner in 1877.

Touch screens are nowadays extensively used
in smart-phones, tablets, laptops and even in
high-end desktop computers. It is a special

type of screen, which can send an input to Touch Screen Tablet
the computer when an item displayed on it is touched.

The figure shows the touchscreen. of an Android based tablet PC.

A touchscreen also acts as a monitor (output device) and displays
the output. So touchscreen is an input cum output device.

5= Did You Know§

Touch screen is a pointing device. Which allows the user to interact
with the computer by touching the screen.

Light pen is pointing device. It is used to choose from among the
various displayed options. As the use the tip of ¥ —

the pen over the surface of the screen it detects
the light coming from screen and responds to
the signal. Light pen is also used to draw high
quality pictures. Light pen is also called STYLUS.  Light Pen

< CPU
CPU stands for Central Processing Unit. CPU is the most

Computer-3 1
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important part of a computer. It controls all the parts géyﬁ
computer. It is also called the ‘Brain of Computer.

The CPU is to process data entered into the computer
according to a given set of instructions and give meaningful
results or output.

Input CPU processes We get output
(Data and instructions) the input after processing

< Output Devices

We know that the result given by the CPU after processing
the data is called the output. Output is shown through the
output devices. Monitor, speakers, headphones and printers
are some common output devices.

< Monitors
The monitor is the primary output device of the computer. It
shows output in the form of text, images, animations, videos etc.

< Speakers and Headphones

The speakers and headphones
give us output in the form of
sound. Headsets which are
commonly used for talking to  Speakers  Headphones — Headset
others through video conferencing are a combination of
headphones and microphone.
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< Printers

Printers are used to print
output on paper. They can
print text and images. Laser Printers
Printers are of many types. Most commonly used types of
printers are shown below:

< Memory of the Computer - RAM and ROM

Computer needs memory to store input, output, programs

and intermediate results of processing. Two types of memory

is generally used in the computer. One is called RAM and the
other is called the ROM.

1. RAM stands for Random Access Memory. RAM is
called read/write memory. A user can read the data
from RAM and also write the data onto RAM. This
memory contains the data until
the power is supplied to it. That JSEEEE=»
means, RAM is the temporary RAM Chip
storage memory.

2. ROM stands for Read Only Memory. 1933535,
ROM is the permanent storage e fineon
medium. It contains the data which is © Infneon 00
the permanent part of the memory. It
is not possible to write data on ROM.

Inkjet Printers
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5= Did You Know§

RAM is a temporary memory and ROM is a permanent memory. RAM

loses data when we which off the computer but data stored in ROM is

not lost when the computer is switched off.

< Storage Devices

We use the storage devices to store data permanently. When
we store data on a storage device, we can refer to it and use it
anytime later. Hard Disk, CD, DVD and Pen Drive are some
commonly used storage devices.

Hard Disk

Hard Disk is also called fixed disk which is fixed
inside the CPU. It is having a large storage
capacity and consists of a pack of large number
of disks. Hard Disk

Compact Disk (CD)

The Compact Disk or CD is a shiny circular disk —
that can store data in any form (video, audio, «/ =
text, images etc.). To read data from a CD, we 4
put it into the CD Drive fixed on the CPU box.  Compact Disk

Digital Video Disk (DVD)

The Digital Video Disk or DVD looks similar —
to a CD but has a darker shiny surface. It can 6-{:’)%
store much more data than a CD. We need a i

DVD Drive to read data stored on a DVD. Digital Video Disk

Computer-3 13 "
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Pen Drive

The Pen Drive is very small in size, which can

store a large amount of data. To read or write data ~ Pen Drive
from a pen drive, we plug it into the USB port of the computer.

< Software

Programs like Paint, WordPad etc., which run on the
computer hardware are called computer software.

Computer software can be put in two main categories:
Application Software and System Software. Let us learn about
them briefly.

< Application Software

Programs like Paint and WordPad, which help you to do a
particular type of task (like typing or
drawing) on the computer, are called
Application Software. Paint and WordPad
are examples of the application software.

MS Windows
< System Sofware operating system

System software are the programs that control the working of

the computer. Operating systems like Windows and Ubuntu
are examples of the system software.

-

[ o
D et e : = o Sm wegen mmy
WordPad is an Software refers o the set of Paint is an
programs which are use (o]
application operateacomputer] application
software software
T T Computer-3
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9‘ Let’s Recall L. =
< !

A computer has two main components namely hardware
and software.

Parts of the computer that make up its physical body are
called computer hardware.

Hardware parts are divided into four main categories-
input devices, output devices, CPU and memory & storage
devices.

QB 5T

A. Fill in the blanks.

1. The monitor is an example of the ................. devices.
2. CPUstandsfor................. .
3. Windowsisanexampleofthe................. software.
B. Write ‘T’ for the True statement and ‘F’ for the False
statement.
1. Youcannotwrite data onto RAM. (:j

2. DVDhasalarge storage capacity as compared toCD. |
3. Memory and storage devices help the computer to store
data only temporarily. ]
C. Answer the following questions.
1. What is memory? Name the types of memory.
2. Define output devices with examples.
3. Compare system software and application software.

' 4
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WINDOWS 8

. @ Windows 8, Features of Windows 8
@ Windows 8 Home Screen, Windows 8 Desktop

@ Windows Charms, Meaning ofa Window
@ Working witha Window

The operating system is the main software of a computer. It

acts as an interface between user and computer. That

supports a computer basic functions, such as scheduling tasks

and controlling peripherals.

< Windows 8

Windows 8 is a personal computer operating system

developed by Microsoft as part of the Windows NT family of

operating systems. It incorporates a number of improvements

and innovations over the previous Windows versions to make

working on computer a simpler, faster and refreshing

experience.

Features of the Windows 8 operating system are as follows:

1. It provides a Graphical User Interface (GUI) to work on
the computer.

2. It allows to make a copy of their OS complete with their
‘. 16 p— Computer-3 q;
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settings wallpapers files and even apps, into a USB drive‘§5

3. It allows you to open many programs at the same time to
work in.

4. Snap multitasking is designed to make it easy to run two
apps in Windows 8 side-by-side to resize them, and to
switch between them. On the right-hand side of the
screen, you can snap an app into place.

5. Windows 8 is equally suitable for both touch screen
devices and mouse operated computers.

6. The load and bootup speed has improved significantly over
windows predecessors. When compared to Windows 7
desktop CPU, Windows 8 has an even speedier boot time.

< Starting Windows 8

When you switch on your

computer, Windows 8 starts

automatically. After sometime,

a screen similar to the one

shown below appears.

ThlS ls the START SCREEN Of Tiles  Scroll bar Right scroll arrow

WindOWS 8 ] Left scroll arrow Windows 8 Start screen Zoom icon

The Start screen is the Home screen of your computer. Its
main parts are:

1. Tiles: Windows 8 live tiles are interactive apps that use

the internet to bring live updates to user of Windows 8.
' » Computer-3 O‘
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£ Live tiles sit on the Windows 8 start screen and are useful
for having instantaneous information on constantly
changing data like stock indexes, international weather,
as well as local and international news.

2. Scroll Bar: The Scroll bar can be dragged towards right
to see the tiles that lie beyond the right edge on the start
screen. You can also move the scroll bar left or right by
clicking on the scroll arrows.

3. Scroll Arrows: Scroll arrows lie on both sides of the
scroll bar. You can click left and right scroll arrows to
scroll the start screen to left and right respectively.

4. Zoom Icon: Clicking this icon shows you the entire Start
screen with all the tiles. Clicking again will bring back
the Start screen and Tiles to the normal size.

Notice that some Start screen area is empty or blank as no

tiles are placed there.

acim—
-

= Did You Know§

Windows 8 has a specially designed touch based interface that is easy to

use on touch based devices.

< Working with Start Screen

Working with Start screen is a lot of fun. Here we will learn
to perform some basic but very important tasks with the Start

Screen.

Computer-3
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Moving the Start Screen \fﬁ

You can move the Start screen left and right by dragging the
scroll bar. This will let you see tiles that lie beyond the right
edge of the screen.

1. Bring mouse pointer over the scroll bar.

2. Click and hold down the left mouse button.

3. Drag the scroll bar to the right. Tiles that lie beyond the
right edge will now become visible.

4. Now, drag the scroll bar towards left to move start screen
in that direction.

< Using the Zoom Icon

We can use the Zoom icon to view all the tiles together on the

Start screen. The steps to use the Zoom icon are given below:

1. Bring mouse pointer over

the Zoom icon and click StartScreen —
the mouse.

2. All the tiles will become
smaller and seen together
on the Start screen.

3. Now click anywhere on the Tiles on Windows 8 Screen
Start screen background. It will return to the normal view.

< Opening an Application Tile

Tiles, as you know, represent programs or applications. To

» Computer-3 _ O‘
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open a program or application tile follow the steps given below:

i 1 B Click int t 1
1. BI'lIlg mouse pointer ick on internet explorer

over the required
tile. Click the left

mouse button.

2. The program or application will

open. Internet explorer application

5= Did You Know?

will open on the start screen

An application will open on the start screen, while a program will
always open on the desktop screen.

< Opening any Program or Application

You can open any program or application loaded on your

computer from the Start Screen. The steps to do it are shown

below:

1. Right click anywhere on the
blank Start screen area.

. the All apps button
appears at the right bottom
corner.

2. Click the All apps button.
. A listing of all the

programs and applications
appears. List of applications and programs

Computer-3 ¢
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3. Click any application/program from the list to open it.
You can drag the scroll bar to see applications listed
beyond the right edge of the screen.

< Closing an Application

To close an application in Windows 8, follow the steps given

below:

1. Bring mouse pointer to the top border of application
screen. _
The pointer will change to a
hand () shape. e

2. Hold down the left mouse | wu o
button and drag the application E

window below the bottom edge Shape of mouse pointer changed
of the screen and release the mouse button.

[W] Hand icon :.—

...the application window will disappear or close down.

5+ Did You Know§

To close a program window, simply click its Close button () ) given at
the top right corner. Remember, application windows do not have a

Close button.
Anal v (10 w [Westem v~ B7UP  ERXSE =
g ......  ERTTTE TR TR e e e ) IO 7.
: ' 4
Close button of the wordpad window 4
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%'Navigating Windows 8
We can use both keyboard and the mouse to navigate in
Windows 8. Here, we will learn to navigate or move around
in Windows 8 by using the mouse.
Using ‘Hot Corners’
Screen corners are very important for working in Windows 8.
They are called Hot Corners because every time you hover
the mouse pointer in a corner, a toolbar or tile will open,
which you can click to perform some actions.

Upper left corner Upper right corner
Lower left corner

Let us learn, what different hot : oy
corners help us to do. woes e g
Lower-left corner: When you are '
using an application or program, you ot commer o the Tomer ot
can click in the lower-left corner to go corner
back to the Start screen. "" |
Upper-left Corner: If you click in the =
uppe.r-left corner, it will switch to the pamsss e o
previous app you were using.

Su 2 Computer-3 &
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& Did You Know¢ %

‘ Win+I is the shortcut key to switch between open applications.

Upper-right Corner or Lower-right Corner: You can hover
the mouse in the upper-right or lower-right corner to open the
Charms bar, which contains several icons. Each icon is called a
charm. Let’s learn about each of these charms in brief.

Search charm: It lets you find applications, files or settings
on your computer.

Share charm: It allows you to “copy” information from one
application and “paste” it into another app.

Start charm: It takes you to the Start screen. If you're already
on the Start screen, it will open the most recent app.

Device charm: It shows all hardware devices that are
connected to your computer, such as printers or monitors.

Settings charm: This lets you access general settings for your
computer as well as settings for the app you're currently viewing.

S .

Operating system is a software that acts as an interface
between the computer and the user.

Windows 8 is a popular operating system developed by
the Microsoft Corporation.

Start screen is the first screen that appears when you
start up your computer. It is the home screen of your
computer.

f Computer-3 23 "
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Rectangular graphics displayed on the start screen are
called tiles. Each tile represents an application or a
program.

1. Each..., is called a charm.
2. s can be used to operate on both touch screen

and mouse operated devices.

3. The Start screen is the ........ccccceeeeee. screen of your
computer.
4. Aprogramwillalwaysopenonthe........................ screen.

B. Write “T” for the True statement and ‘F for the False
statement.
1. Win + M is the shortcut key to switch between open
applications. ]
2. Window 8 developed by Microsoft Corporation. ]
3. We cannot use Windows 8 to operate touch screen

devices such as tablets and smart phones. )

'3
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C. Tick (v') the correct option.
1.

a. Tile b Operating System )
c. Start Screen D
Which of these is called the Home screen of the

computer?

a. Desktop (] b. Start screen ]
c. Scroll bar )

Which of these is not a charm?

a. Search (] b. Devices )
c. Desktop )

D. Answer the following questions.

1.

A

E Computer-3
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What do you mean by scroll bar?
List 3 features of Windows 8.
What are hot corners?

What is zoom icon?

What are tiles?
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Fun With Paint

_ @ Starting Paint @ Components of a Paint Window
} @ Working with Paint Tools

Hi, children! Paint is a very interesting application |
of Microsoft Windows. It can be used to create
drawing on a blank drawing area and can also be

used for editing pictures.

< Starting Paint
To start Paint, follow the steps:

1. On the Start Screen, click on the Paint.
The following Paint window appears _ ;
on the screen. Paint Window

< Components of a Paint Window

Quick Access Toolbar

The top lines of the window is a Quick Access Toolbar. It
includes page title, undo, redo save and open on.

To put the commands you use most often in Paint, put them
on the Quick Access Toolbar above the Ribbon.

0
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To add a Paint command to the Quick Access Toolbar, righ g
click a button or command and then click Add to Quick
Access Toolbar.

ERE SR - 2 - Paint » - s IEN
. — e -0
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Mipimise the Ribton

Customizing quick access toolbar

< File Tab

It is present just below the Quick Access toolbar. It consists of
different menus to work in Paint.

[T w 2-faint - ER
\ O
0t sl Lyoazes o [S[ ) MuEnE llllu

Ribbon [T oo = pReEsEe: o SMAE MERE |
The Ribbon holds all of the
commands. It has two parts:

1. Tabs 2. Groups a0 0 ®e @3B0

Ribbon of paint
Each tab contains commands arranged in different groups.

Drawing Area

A drawing area is a blank white area in which user can create
the drawing. It is also called canvas.

Computer -3
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Z~Status Bar
A status bar is a horizontal bar window at the bottom of a
parent window in which an application can display various
kinds of status information. Here you can see general
information about the current image.

D e s 3-Paint

. t [ "Haw [ 4 N\~/OOOBA - [ utine B MEEEE EEEE g
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Home tab

Working with Paint Tools
To start drawing in Paint, you use Home tab.

Observe the different groups. To start with, you will learn
some commands of Tools, Shapes and Colors group.

Tools group: It consists of different tools and brushes.

Shapes group: It consists of a variety of ready-made shapes
for your ease.

Colors group: It has colors to select for your drawing.

< Pencil Tool

Pencil tool is used to make free hand drawings, follow the
steps:

1. On the Home tab, in the Tools / /\
group, click the Pencil tool. Nl
2. In the Colors group, click Color 1, =~/ /
select a color. Using Pencil Tool
s 23 Computer-3 q;

A5 IR S S .9 B e




3. Drag the pointer in the drawing area to draw.

& Did You Know?

To draw a perfect square, just keep the shift key on the keyboard
pressed while dragging the mouse.

< Eraser Tool

Eraser tool is used to erase the portion of //\

object or entire object, follow the steps:

1. On the Home tab, in the Tools group, e e,
click the Eraser tool. a— e

2. Drag the eraser to erase the drawing. ~ Using Eraser Tool

& Did You Know?

You may increase the size of eraser by pressing Ctrl and + [plus] and to
decrease the size press Ctrl and - [minus].

Shortcut Key
To create a new paint file, press Ctrl+N.

< Curve Tool
To draw a smooth curved line, follow the steps:

1. On the Home tab, in the Shapes =%
group, click the Curve tool. / /\ \
2. Click Size & then select a line size, ﬂ /\J
which determine the thickness of e
the line. Using Curve Tool o
» Computer-3 29 _w»

FE @o

—_— S 75 oY
B 0.5
P




sl

\‘k' In the Colors group, click Color 1, click a color and then
drag the pointer to draw the line.
To draw a line that uses the Color 2 (background) color,
right-click while you drag the pointer.

4. After you have created the line, click the area in the

picture where you want the arc of the curve to be and
then drag the pointer to adjust the curve.

< Fill with Color Tool

This tool is used to fill an object with a particular color,
follow the steps:

1. On the Home tab, in the Tools . =
group, click the Fill With Color //\ \
tool. i

2. In the Colors group, click Color 1, ﬂ A

A —

click a color.

/
i : : : Using Fill with Color Tool
3. Bring the pointer in the drawing ~ © = " 0000

area to fill it with the foreground color.

5= Did You Know¢

The color will leak if the shape is not closed.

Fill color in your drawing using Fill With Color Tool.

< Saving a Picture
After creating a new drawing, you must save it so that it can
be used as and when required, follow the steps:

"Q. 30 - - - Computer-% ..,f_,'{-
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1. Click the File Tab and then -
click Save. r

2. In the Save as type box, select
the file format you want.

3. In the File name box,

type a name and then chck Save.

.......

.........

P — e Select the
You may choose the approprlate desired file format
option.

& Did You Knowg

On closing Paint, computer asks ‘Do you want to save changes to.

(7 Lot's Recall L

Pamt is used to create drawings.
The components of a Paint window are:
O Quick Access Toolbar © Tab Buttons
O Ribbon O Drawing Area
O Status Bar
Curve tool is used to draw smooth curved lines.
Paint provides different ready-made shapes.

0‘
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A. Fill in the blanks.
1. Paintisusedtocreate................ :
2. Drawingareaisalsocalled................ :
3. Penciltoolisused tomake................ drawings.

. tool erase lines or part of the picture.

B. Write ‘T’ for the True statement and ‘F’ for the False
statement.

1. User can not saves his drawings.
2. To create a new paint file, press Ctrl+O.

3. Drawing area is a blank white area.

OUud

4. Paint provides differents ready-made shapes.
D. Answer the following questions.

1. Explain the use of the ‘Eraser’ tool.
What is the use of pencil tool?

Define status bar.

ol

What is drawing area?

Computer-3 ¢
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Wordpad

_ @ OpenWordPad @ Components of WordPad Window
@ HowtoTypein WordPad  # SavingaDocument
@ Openinga Saved Document ¢ Closing WordPad

Hi, children! WordPad is a text-editing application
which can be used to write letters, stories, poems
and to create and edit documents.

< Opening WordPad

To open WordPad follow the steps:
1. On the Start screen.

2. Click WordPad. -
2 Components of a WordPad Window ©lick WordPad program
1. Quick Access Toolbar 2. File Tab

3. Ribbon 4. Title Bar
- _—
Hic = e BgMH 6
WordPad Window
Computer 3 | ) '0




Q%' Quick Access Toolbar

The top line of the window is
Quick Access Toolbar. It includes
page, title, undo, redo, save and open button.

< File Tab

It is present just below the Quick = _,
Access Toolbar. It consists of different |-
commands to work in WordPad. e

Click on the File tab to select the

r eqUiI'ed command. Commands in File "fab |

< Ribbon — — —
Ribbon can be used to change the ? s, oL EETE: “
formatting in a document. [ ———

It has two parts: 1. Tabs 2. Groups

Each tab contains commands The Tabarelocated across the
. . top of the ribbon under the title bar
arranged in different groups.

< Title Bar
‘Ql—g = | Document - WordPad = 8 J
Title Bar

It is located at the top of the WordPad window. The Title bar
displays the name of the document on which you are
currently working. By default, WordPad names the
document, as Document. When you save your file, you can
change the name of your document.

‘. 34 Computer-3

OB § G e ate

L2

\ K




-

[ 33
< Zoom %

To zoom in and out in a document, you can also click the
Zoom in (¥) or Zoom out (=) buttons on the Zoom slider in
the lower-right corner of the window to increase or decrease
the zoom level.

< How to Type in WordPad

You may start typing your text, — TR
using keyboard. You may use _ A
different fonts (styles of writing)

for typing. Font Group

You may also make bold, italic and

underline certain words.

< Saving a Document

After finishing your work, it is always important to save it, so
that you can reuse it as and when required.

To save your work, follow the steps:

1. Click the File tab. 2. Click the Save option.

Dosames - WaondPad G- [ & - Save ha = |
©

Magebanrou

E D%

Documents
........

T
E
i
1
|4

Save Option on File tab Save as dialog box S
<
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\‘%' In the File name box, type the name of the file.
4. Click the Save button.

Shortcut Key
To save changes to a document, press Ctrl+S.

< Opening a Saved Document

To open a file, follow the steps: &= . ==~
1. Click the File Tab. = —~  ||= =
2. Click the Open option. - i
3. Click the file that you want.
4. Click the Open button.

Opening a file Open dialog box |

< Closing WordPad o m.,.,,: — -
After you finish your work, close o BE3es
WordPad program. SR

1. Click the File Tab. |o,., I

2. Click the Exit option. e

- WordPad is a text-editing program, you can use to create
and edit documents.

To zoom in and out in a document, you can also click
the Zoom in @ or Zoom out @ buttons on the Zoom
slider.

You may use different fonts (styles of writing) for typing.
You may also write bold, italic and underlined words.

Computer-3 ’{




Fill in the blanks.

1. Thetoplineofthewindowas................ toolbar.

2. Toenter textina WordPad file,youuse................ :

3. Theribbonisusedtochangethe................ in adocument.

Tick (v') the correct option.

1. WordPadisa................ application.
a. Text editing b Drawing ]
2. WordPadisaprogramfor................ text on the computer.
a. Typing (] b. Drawing L]
30 e, is used to save a document.
a. Ribbon )
J

b. Quick access toolbar
Answer the following questions.
1. Name the part of WordPad Window.
2. What is Quick Access Toolbar?

3. Why is it important to save a document?

' 4
\.\ 0‘
‘ E- Computer-3 o~ e 37? ?“d
& f—] ? = v /‘l Ii‘?‘d




Basic file operations

Savingafile
Closingafile
Openinga saved file
Selecting text

MS Word 2013

@ Howtoopen MS Word 2013

@ Parts of the Word Window

@ Typinginthe Word

@ Creatinganew file
@ Deleting texst

@ Inserting text
@ Existingword

Hi, children! Microsoft Word 2013 is a word

processing program designed to help you create

professional quality

organize and write your documents more efficiently.

< Opening MS Word

To start MS Word:

1. Go to the Start screen.

The following Word

window appears on ~°
the screen with a

blank document.

’
‘~ &

documents. Word helps you

2. Click the Word 2013.

Signin §

Styles

Default Window of Microsoft Word

& -
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< Components of Word Window \ﬁ
The word window consists of the following components:
Let us know about these components in details.
1. The File Tab: The File tab is present - “—-== o oo o 27 5

okl Bty

in the upper left corner of the window. - *
When you click the button, a menu
appears. You can use the menu to create |
a new document, open an existing file |
or save a file. Other options are save as, W
print, send, publish and close. access toolbar

2. The Quick Access Toolbar: Above the File tab is the
Quick Access toolbar. The Quick Access toolbar provides you
with access to commands, you frequently use. By default Save,
Undo and Redo appear on the Quick Access toolbar.

You can also customize the Quick Access Toolbar by checking
or unchecking the items  © ol Tt

. . . FilcTabﬁ— ”,. .. e
available in the Customize B i e il | o
Quick Access Toolbar drop- |
down box. Shortcuts for the Rulers Serollbas

items that are checked will | Status Bar

T)O(‘L’mq:;i |
appear in the toolbar. hren |

. Components of word window
5= Did You Know§

You can place the Quick Access toolbar above or below the Ribbon. To
do so, click the arrow at the right end of the toolbar and then click Show
Below the Ribbon from the Customize Quick Access Toolbar dialog box.

f Computer-3 39 "
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:%3}' Title Bar: Next to the Quick Access toolbar is the Title

bar. The Title bar displays the title of the document on which
you are currently working. Word names the first new
document you open as Documentl. As you open additional
new documents, Word names them sequentially such as
Document2, Document3 and so on. When you save your
document, you can assign the document a new name.

4. Ribbon: The Ribbon is the panel at the top of the Word
2013 workspace and below the Quick Access Toolbar. You
use the ribbon to give instructions.

The Ribbon has several tabs including Home, Insert, Page
Layout, References, Mailings, Review and View. Clicking a
tab displays several related command groups. Within each
group, there are related command buttons that you will use to
perform various operations while you're creating a
document.

5. Tabs: Each of the tabs contains groups. For example, the
Home tab contains group as Clipboard, Fonts, Paragraph,
Styles and Editing.

e
-,

& Did You Know§

6. Rulers: The rulers are v . I t
found below the Ribbon | on €87 ShOW OF Aide e. ocumen
rulers by following the steps:

and above the document || ik the View Tab in the Ribbon.

window and also on the |, (Click the check box next to Rulers.
left side of the document. |3, To hide the rulers, uncheck the box.
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7. Text/Document Area: Just below the ruler is a large art:% >
called the text area. You type your text or content in the text
area.
The blinking vertical line in the upper-left corner of the text
area is the cursor or the insertion point. As you type, your
text displays at the cursor location.
8. The Vertical and Horizontal Scroll Bars: The horizontal
and vertical scroll bars allow you to move up, down, and
across your window by dragging the icon located on the
scroll bar.
The horizontal scroll bar is located just above the status bar
and is used to move back and forth across your document.
You won't see a horizontal scroll bar if the width of your
document fits on your screen.
The wvertical scroll bar is located along the right side of the
screen and is used to move up and down your document.
9. Status Bar: The Status bar appears at the bottom of your
window. It provides detailed information about your
document, such as the current page number, the word count,
section number, line number etc.

===

< Opening a New Document

To create a new document,
follow the steps: Opening a

1. Click the File tab. new document

Computer-3
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& . Select New.

3. Click the Blank Document.

Shortcut Key

To create a new document, press Ctrl + N.
< Saving a Document

To save a document, follow the steps:
1. Click File tab.

2. Select Save as.

3. Click Computer.

4. Click Browse.

The following Save as dialog box appears.

Save As

i OreDrve

.......
L omputer L

::::::

o st o e

5. Type the file name. e o

6. Click the Save. = s
The word document automatically i==
adds a period and an extension .

= ke Faidan Toaki = St Cancel

docx to the file name. Save as dialog box

Shortcut Key

Click the Save button on the Quick Access Toolbar or press
Ctrl+S.

< Opening an Existing Document
To open a document, follow the steps:
+ L. Click File tab. 2. Select Open.

®
‘. 42 - .. Computer-3 &
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3. Click Computer. 4. Click Browse.

The following Open dialog box appears. o

5. Select the required file. 6. Click Open.
i _:_k . o ." Opening a saved file |
= ;; sisiz.d  Open dialog box

< Typing Text in a Word Document

When you start typing text in your document, you observe a
small vertical blinking line in the work area of Word screen.
This is called the cursor. It appears in the upper left corner of
your new word document.

When you type the text, the insertion point moves to the
right. When you come to the end of line, continue typing the
text, do not press Enter key. The text will automatically move
to the next line. This feature of MS Word is called Word
Wrapping.

To start a new paragraph, press the Enter key. On reaching
the end of a page, text will be typed automatically in the next

[ pms———
a e Bl s s oo suor  meees s R
‘ [ B iz =] 4 mae T :
| ¥ i o AaBbCcDx MaBblcDe AF =
|Poste o W N e A a .-' Harmel | Motpec_ Massngt ;| ARG

When you start typing text in your donament you observe a small vertical blinking line

Typing textin a
word document T S

When you type the text the msertion point moves to the right. When you come to the
end of liree, contimue fyping the est, do ot press Enter key. The text will sutomatically
‘mave to the next line. This frature of MS Ward is called Word Wrapping.

To start 4 v pasagraph, prass the Enter ke, On seaching the end of  page. fuxt will
e typed aitomatically in this nast pags]
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S You can Bold, Italic and Underline the text by clicking the

Bold (B), Italic (I) and Underline (U) icons on the Home tab

in the Font group.

Italic Button
It tilts the selected text

Bold Button ‘ Underline Button
It makes the selected ——M ——— Itgivesa line below
text dark. the selected text.

Bold, Italic and Underline
To select text:

Before applying formatting to text, you will first need to
select it.

1. Place the insertion point next to the text you wish to
select.

2. Click the mouse and while holding it down, drag your
mouse over the text to select it.

3. Release the mouse button. You have selected the text. A
highlighted box will appear over the selected text.

To delete text:
There are several ways to delete or remove text:

1. To delete text to the left of the insertion point, press the
Backspace key on your keyboard.

2. To delete text to the right of the insertion point, press the
Delete key on your keyboard.

3. Select the text that you wish to remove then press the
Delete key.

‘. 44 Computer-3
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< Closing a Document
To close a document, follow the steps:
1. Click the File tab. 2. Select Close. slEm— -

If you haven't saved the document, it A =
prompts you to save. Click the Save e =,
button to save the document or click
the Don’t Save button, if you want to

close the file without saving it.

Closing a document

1 Want to save your changes to Document1?
H

i you click “Don’t Save”, a recent copy of this file will be tempararily available.
lg am mgr 4

Shortcut Key o] i) [
To exit word press Alt + F4. Prompt to save file

&' Let’s Recall '@
- -

A word processor is an application software, used to type text
or content on computer.

The Title bar displays the title of the document on which you
are currently working.

The Quick Access toolbar provides you with access to
commands you frequently use.

The Ribbon has several tabs.

I‘JV-

QDX E[RIC] 11SIE]

A. Fill in the blanks.

1. The word document automatically adds a period and an
extension................ to the file name.

2. Microsoft Wordisa.................. software.

4
4
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3. The ... tab is present in the upper left corner of
the window.

B. Write ‘T’ for the True statement and ‘F’ for the False

statement.
1. Aword processorisan application software.

2. TheRibbon has only one tab.

3. Toexitword, you can press Ctrl + F4.

oudd

4. 'Tostartanew paragraph, press the Enter key.
C. Tick (v) the correct option.
1. To exit word you can press ..................... :
a. Alt+E4 [ Jb. Alt+F4
2. Next to the Quick Access toolbar is.
a. Title bar [ Jb. Status bar
3. Toopenadocument, press.

a. Ctrl+N [ Jb. Ctrl+O

8

8

D. Answer the following questions.
1. Whatis WordPad?
2. List the information that you can view in Status bar.

3.  Write steps to open and save a file in WordPad.

Computer-3 “g
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Internet

. @ Whatisinternet? @ Usesofinternet.

@ BasicInternet Terms: (World wide web, Web site, Web pages,
Web browser, Hyperlinks, Email)

@ Internetexplorer

Hi, children! You can play online games and chat
with your family or friends staying far away.

a

Ay

When two or more computers are connected to each other to
share the information and resources, is called computer
network. The word Internet is a combination of two words;
inter' meaning between and 'net' meaning network. It is a
collection of interconnected computer networks from around
the world that provides lots of information on any topic you
can think of.

It is one large network composed of many smaller networks.
It connects millions of computers through cables, telephone
wires or at times wireless media of communication.

§° Computer-3




\‘% Uses of Internet

Following are the uses of Internet:

It is a worldwide network of computers that share

1. NHENE Y e Ry o
AT A ot N8P P

Friends and Family members communicating over the Internet.

information. The primary purpose of Internet is information
sharing and communication. You can

communicate with friends and family far off.

You can search any topic and learn more.

You can send and receive messages using e-mail.

Sending e-mail

Computer-3 3
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< Requirements for an Internet Connection ‘f/
To connect Internet to a computer, you require the following:

J A telephone [ A modem or a network card

A modems is a device for connecting computers by a
telephone line. This networking devices converts analog and
digital data for computer-to-computer communi-cation.

Software (web browser)

Web browser is an interface that allows you to control
information on the Web. The browser connects to the server
to which you're connecting, picks the Web pages and displays
them. Examples of web browser are Internet Explorer,
Google Chrome and Mozilla Firefox.

Internet Service Provider (ISP)

A company that provides Internet connection.
< Terms Related to Internet

Let’s understand the internet terminology.

Protocol is the rule that orders, how you get the required
information from the Internet.

Website is a collection of web pages.

Web Page is a collection of text, pictures, videos, animation etc.

_' . 4
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SWorld Wide Web [WWW]is | © m——
a collection of related web
sites. Go 81_@
WWW server is a computer N p—
that is a store house and
provides access to Web | oo~ o
documents. Google Chrome
Home page is the first page that is opened, whenever you
start your web browser. This page can be changed according
to your settings.
< Internet Explorer
You can browse Internet through Internet Explorer (IE) or
Google Chrome. On double clicking the icon on the Desktop,
you will be greeted with the Google window.
Web Page or Display Area
The web page is displayed in this area.
Address Bar
The address of the web site is typed into the Address bar text
box. Press Enter or click Go on the address bar to view the
web page. The web address is generally given in lowercase
letters but is case insensitive. There are no spaces in a web
page or web site address.

‘Q 50 Computer-3
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The web browser has the following buttons:

Back

Forward
Stop
Refresh

Home

Search
Favorites

History

Mail

Print

Computer-3
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To go back to previously viewed web page.

To go forward to a web page that was viewed just
before using the Back button.

To stop the loading of the web page from that
point forward.

To refresh/reload the contents of the currently
displayed web page. It helps in loading of a web
page, if it stops in between due to some fault.

To go to the Home page of your web browser.

To search for the text entered in the address bar.
You may type in any combination of
alphanumeric characters to search a web site.

Displays a list of previously book marked web
sites. You may add, delete or create folders for
related web sites in the Favorites section.

Displays a list of previously viewed web sites
along with the date and time.

Starts the E-mail program.

Prints the web page with the default settings of

e
¢ e

the printer.
- g 2 4
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FStatus bar Displays the status of the current web page.

If Google Chrome is not your default browser then it will ask

you to set it as default. If you wish so then click Set as
default.

R(\f" T
./ *licoogle *

" 3 & # ) www.googlecom

Google

Google Search  I'm Fealing Lucky

Adveriising Programs  Business Sclutions  About Google

2010 - Privacy

Change background image

Google Chrome

(7 Lot's Recall L

Internet is often described as a network of networks.
The Web consists of pages that contain lots of information.

Home page is the first page that is opened, whenever you
connect to a web site.

Internet Explorer also consists of toolbars for example - Title
bar, Menu bar, Standard toolbar and Status bar.

0
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A. Fill in the blanks.

| O is a collection of web pages.
2. displays the status of the current web page.
3. The ..ccccec... button takes you back to the previously
viewes web page.
U button is used to refresh the web page.
B. Write ‘T’ for the True statement and ‘F’ for the False
statement.
1. Historydisplaysalist of previously viewed
websites. )
2. WWW: isacollection of websites. ]
Protocolisaset of rules for the Internet. )
4. ISPisacompany that providesinternet
connection, ]
5. Modem s essential for internet connectivity. )

C. Answer the following questions.

1.
2.
3.
4

E Computer-3
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Write the names of some web browsers.
What do you mean by home page?
Whatisamodem?

What are www, website and webpage?
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@ DESKTOPR AND START MENU
IN WINDOWS 10

. @ TheLockScreen @ TheLogin Screen
@ TheDesktop @ Meet the Start Menu
@ Start Menu - The Left Side @ Start Menu - The RightSide
@ The Sleep/Shut Down/Restart Commands

Windows 10 is a personal computer operating system. It was
developed and released by Microsoft in July 29, 2015.
Windows 10 is the most powerful operating system that
Microsoft has ever made.

Windows 10 restores the desktop to its traditional
importance. The desktop is once again your only home base,
your single starting point. It's the view that greets you when
the computer turns on, and it offers all the tools you need to
manage and organize your files.

< The Lock Screen

When you turn on a Windows 10 machine, the first thing
you see is a colorful curtain that's been drawn over the
computer's world. It's the Lock screen. The Lock screen
serves the same purpose it does on a phone: It gives a quick

glance at the time, the date, your WiFi signal strength, the
‘. 54 Computer-3 ’g
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weather, and (on laptops and tablets) your battery charﬁ -
When you do want to go past the Lock screen to log in,
there's nothing to it. Almost anything you do that says, “I'm
here!” works:

J Touchscreen: Swipe a finger
upward.

J  Mouse: Click anywhere. Or turn
the mouse wheel.

J  Keyboard: Press any key.

< The Login Screen The Lock Screen

As in any modern operating system, you have your own

account in Windows. It's your world of files, settings, and

preferences. So, the second thing you encounter in Windows

10 is the Login screen. This is also where you're supposed to

log in—to prove that you're you. But logging in no longer has

to mean typing a password. One of Windows 10's primary
goals is to embrace touchscreens, and typing is a pain on
tablets.

Therefore, you can log in using any of these techniques:

J Just look at your screen. On laptops or tablets with Intel's
RealSense infrared cameras, facial recognition logs you
in.

J Swipe your finger across the fingerprint reader, if your

+* Computer-3 - - 55‘ '0‘
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~ computer has one.

. Put your eye up to the iris reader, if your machine is so
equipped.

J Draw three lines, taps, or circles on a photo you've

selected.

Type in a four-digit PIN number you've memorized.

Type a traditional password.

Skip the security altogether. Jump directly to the desktop

when you turn on the machine.

< The Desktop
Once you've gotten past [#

U OO

the security barrier, you [ ‘ 3 Windows 10
finally wind up at the FS8 "

home base of Windows:
the desktop.

You can make the ¥
desktop look like
whatever you want. You
can change its background picture or color scheme; you can make
the text larger; you can clutter up the whole thing with icons you
use a lot.

s+ Did You Know¢

Windows 10 will keep personal and corporate data separate.

0
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< Meet the Start Menu

Windows 10 is composed of 50 million lines
of computer code, scattered across your
hard drive in thousands of files. The vast
majority of them are not for you; they're
support files, there for behind-the-scenes
use by Windows and your applications.
They may as well bear a sticker reading, “No

user-serviceable parts inside.”

That's why the Start menu is so important. It lists every useful
piece of software on your computer, including commands,
programs, and files. Just about everything you do on your PC

begins—or can begin—-with your Start menu.

In Windows 10, as you've probably noticed, the word “Start”
doesn't actually appear on the Start menu, as it did for years;
now the Start menu is just a square button in the lower-left
corner of your screen, bearing the Windows logo ( ). But it's
still called the Start menu, and it's still the gateway to
everything on the PC.

You can open the Start menu with the mouse. If you feel that

» Computer-3 '0
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:%Ef'e's too short, however, tap the key on the keyboard instead,
or the button if it's a tablet.

< Start Menu: The Left Side

The most amazing thing about the Windows 10 Start menu is
that Windows 10 has a Start menu—something that's been
missing since Windows 7. The left side, or something like it,
has been with Windows from the beginning. The right side is
a pared-back version of the Start screen that distinguished
Windows 8.

The left side may look like the Start menu that's been in
Windows from the beginning (except during that one
unfortunate three-year Windows 8 phase). But there's a big
difference: In Windows 10, you can't use it to list your own
favorite programs, folders, and files. (That's what the right
side is for.) The left side is meant to be managed and run

entirely by Windows itself.
< Start Menu: The Right Side

The right side of the Start menu is all that remains of the Great
Touchscreen Experiment of 2012, during which Microsoft
expected every PC on earth to come with a touchscreen. Instead
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of a Start menu, you got a Start screen, stretching from edge%ﬁ

edge of your monitor, displaying your files, folders, and

programs as big rectangular tiles.
< The Sleep/Shut Down/Restart Commands

If you really want to do the sleeping or shutting down thing
using the onscreen commands, you'll be happy to know that in
Windows 10, you no longer need 20 minutes and a tour guide
to find them. They're right there in the Start menu, near the

bottom. Choose Power to see them.

Shutting down is only one of the options for finishing your

work session. What follows are your others.
Sleep

Sleep is great. When the flight attendant hands over your
pretzels and cranberry cocktail, you can take a break without

closing all your programs or shutting down the computer.
Restart

This command quits all open programs and then quits and

restarts Windows again automatically. The computer doesn't
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\ = I =
- A - c -}_ e ) . Vi ,0“‘
@ ‘—j > 0 — La [ 158 ‘




:%:c'tually turn off. You might do this to “refresh” your
computer when you notice that it's responding sluggishly, for

example.
Shut down

This is what most people would call “really, really off” When
you shut down your PC, Windows quits all open programs,
offers you the opportunity to save any unsaved documents,
exits Windows, and turns off the computer. There's almost no
reason to shut down your PC anymore, though. Sleep is
almost always better all the way around. The only exceptions
have to do with hardware installation. Anytime you have to
open up the PC to make a change (installing memory, hard
drives, or sound or video cards), you should shut the thing

down first.

- The Lock screen serves the same purpose it does on a phone.
The second thing you encounter in Windows 10 is the login
screen.

Windows 10 is composed of 50 million lines of computer code.
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A. Fill in the blanks by choosing correct word from the
brackets.
1. Windows 10is developed andreleased by .................
(Microsoft/Micromax)
2. The colourful curtain that's been drawn over the computer's
world isthe.................. (Lock screen/CPU)
3. Windows is composed of .............. million lines of
computer codes. (Forty thousand/Fifty million)
B. Write ‘T’ for the True statement and ‘F’ for the False
statement.
1. Windows 10 will keep personal and corporate data
separate. L]
2. Youcannotopen the start menu with the mouse. )
Restart command quits all open programs and then
quits and restarts windows again automatically. )
4. XPiscomposed of 50 million lines of computer code. (|

C. Answer the following questions.

1.
2.
3.

Computer -3

@’ -

Whatis thelock screen?
What is one of the Windows 10's primary goals?

What is the most amazing thing about the Windows 10
start menu?
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Model Test Paper - 1

B. Fill in the blanks.

1. Desktop computers are kept on ....................... :
20 e, founded the IBM company.
3. The .o, and headphones give us output in

the form of sound.
C. Answer the following questions.

1. Define operating system.

"
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Model Test Paper - 2

A. Fill in the blanks.
1. Paintisusedtocreate................ :

2. Drawingareaisalsocalled................ :

3. Penciltoolisused tomake................ drawings.
4 e tool erase lines or part of the picture.
5. The.......... button takes you back to the previously

viewes web page.

B. Identify and name the icons.

B. Write ‘T’ for the True statement and ‘F’ for the False

statement.

1. To create a new Paint file, press Ctrl + S on the

Internet. )
2. Internet is one small network composed of many
large networks. ]
3. The Ribbon has only one tab. ]
4
o’
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™

&
‘*‘% 4. To delete text to the right of the insertion point,
press the Back Space key on your keyboard. ]

C. Answer the following questions.
1. What is Wordpad?

i
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